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@3 Introduction

In keeping our commitment to support our National Offices, Seiko Hong Kong Ltd has created
an interactive advertising and promotion planning resource for our valued partners.

This user guide will show you how to access our full complement of images and materials for
Pulsar, Lorus and Alba.

This system provides unprecedented control of (ad planning) and production, including:

+ Self-service, online access to the Image Library, Logos, Retail Planner Materials,
POS, GWP & Box Catalogues, Operational Guides and much more

« Options to view, download to your PC in EPS or JPG formats. No special graphics
or computer skills are required to access or transfer images

 Easy navigation
+ Fast delivery to publications, agencies, cable stations or websites
* Support for all advertising and point-of-sale initiatives

* Reduced time to market
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3 SEIKD Hong Kong Ltd. - Microsoft Internet Explorer

LUGINE UF HESYS 1 EN]

In Keeping our commitment to support our National Offices, Pulsar-Alba-
Lorus have created an interactive marketing planning resources for our
valued partners.

Login: [
Password: |

Forgot your User ID or Password? Please contact to
Pulsar, Alba & Lorus Division, SEIKO Hong Kong
Limited.

To view a Tutorial of this site Click Here.

1. Enter login name in the “Login” field.
2. Enter password in the “Password” field.
3. Click “Submit” button to log on the site.

Note: If you forget your user ID or password, please contact Pulsar, Alba & Lorus Division, SEIKO

Hong Kong Limited.
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o3 Navigation

2} SEIKO Hong Kong Ltd. - Microsoft Internet Explorer

PULSAR

it’s all in the details

Selling Features of Pulsar
Over Competition

Selling Features of Pulsar '
Watch ‘

Communication

Best Proposed Assortment »
Image Library »

Logos *

Manufacturer’s Brand

Brand Essence Film

WMD (Visual Mucmwsizo
Catalogue *

Glossary of Watches

Care of Watches

Band Sizing

Calibre Information

Operating Manual
Download Area

PULSAR

Toview a Tutorial of this site click here

s o st

T daas v pcv € Trihanalh )
s Ros music; = i

{ frarrmpreon amndoasile f-m“-:g_

Radoos syt Lrws s

Fornmer vegan

Witrs o Pralsar

PULSAR

£y
s

List of Distributors

PULSAR

Left menu navigation bar
e  Enables you to access any section of the site.

Top menu navigation bar

™ Enables you to access any brand site such as “Pulsar, Lorus and Alba“.
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©3 Image Library

Let “Image Library” as an example. If you roll over the “Image Library” text, you can make a
selection from dropping down the menu. In this case, the dropped down menu includes:

PRESTIGE
POISE
PERFORMANCE
PRELUDE

PULSAR

it’s all in the details
y PR e~
Admin Pages Pulsar » Lorus « Alba To view a Tutorial of this site click here

Home
wmawe ey L

Pulsar Today! Mission

Selling Features of Pulsar
Over Competition

Selling Features of Pulsar
Watch

Communication

Best Proposed Assortment »,
Image Library *
Logos *
Manufacturer's Brand
Brand Essence Film
VMD (Visual Merchandising)
Catalogue *

Glossary of Watches PULSAR

Care of Watches | e O ——
Band Sizing

Calibre Information

Operating Manual

Download Area

List of Distributors

o Bucien PULSAR

[ Jrarmmapaoss sann
Rndlros llt P
[ ormer vegan

Wours o Phalsar 1
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o3 Image Library (cont.)

Example

L
[x

PULSAR

it’s all in the details

Admin Pages Pulsar » Lorus « Alba To view a Tutorial of this site click here

Home
wowenssnsoy M.
Pulsar Today/ Mission
Selling Features of Pulsar
Over Competition s
Selling Features of Pulsar
Watch
Communication
Best Proposed Assortment »
Image Library *
Lovs > -
Manufacturer's Brand PERFORMANCE » (BRACELET & STRAP) & L it s
Brand Essence Film PRELUDE * GENTS 50M WR ;.//.; Surriag wkedeel'y
woarr et DT 1
::.::;“1 Merchandising) L',_ ml..“l,gﬂg:rcsﬂ.snsmnm o :‘,:: '_”_L' '
Glossary of Watches g GENTS STRAP = = pULSAR |
Care of Watches | = MECHANICAL ——-;____,__-———""-‘_
Band Sizing LADIES 100M WR
Colirs ormation EiCREra SR
Operating Manual (BRACELET & STRAP)
o A LADIES BRACELET
List of Distributors GRS
Sorvios Hetvvork EXCLUSIVE MODELS PULSAR
Extranet NURSEWATCHES
ALk b

1. Roll over “Image Library”, choose "PRESTIGE" and then click “‘CHRONOGRAPH"”.
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©3 Image Library (cont.)

) 54 1X0 Hong Kong Ltd, - Microsoft Internet Explorer

PULSAR

it's all in the details

Admin Pages. Pulsar + Lorus + Alba To view a Tutorial of this site chick hore

Who We Are & History Im’lﬂe I.ibr'z'v 4
Putsar Today! Mission - IGE - R0 3 APH

Sofling Foatures of Pulsar  Print This Page + Print Al + Setup Detalls + Advanced Search
Over Compatition Read Print Instructions

Selling Features of Pulsar Page 2 of 11
Watch
Chick on the model nformation and download options.

PFI2S1XY
Band Sizing M2 SS me2 s
Calibre Information 55 55
Oper ating Manual L o w0 o

Dovenload A PIO24X G PIORSX G
100M PRE co 100M PRE co 4

List of Distributors 4900969410734 4500969410741
Sorvice Network

N :l

o Click “Print This Page*” to print the current page.

-

o Click “Print All* to print all products information in the current category.
o Click “Setup Details" to configure the product details.

o You can search the products by clicking *“Advanced Search”
°CIick “Read Print Instructions® to read print instructions.

°Sh0ws how many total pages are there and what page you are at.

o Click “Previous” to back to the previous page and Click “Next” to go to the next page.
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©3 Image Library (cont.)

J SEIKD Hong Kong Ltd, - Microsoft Internet Explorer

ps— Chick on the image for model information and download options.
Best Proposed Assortment >
Image Library »
Logos *
Manufacturer’s Brand
Brand Essence Film
VMO (Visual Mer chandising)
Catalogue *»
Glossary of Watches
Care of Walches
Band Sizing — PFIZEIA
Calibre information s
Opaor ating Manual MC  SCB oL
s
Download Area 100M D:me co
List of Distributors 4900969410741
Senvice Network
Extranet
Website
D o (@) o
_ -
PFI2TZXY

Edit | Detadls

[l

o Click the picture for details of the product.
o Information of the product.
w Click “Edit" to insert data in the “DF* field.

@ Click “Details” to view the details of the abbreviation.
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o3 Image Library (cont.)

Setup Details

] SEIED Hong Kong Ltd, - Microsoft Internet Explorer ‘m’.&ll

PULSAR

it's all in the details

Admin Pages Pulsar « Lorus » Alba Toview a Tutorial of this site chick here

Home =

W

Putsar Today! Mission PRESTIGE - CHRONOGRAPH

Selling Features of Pulsac  Print This Page + Print Al Advonced Search

Ovor Competiion Read Print Instructions

wm‘""" Page 2 of 11 Previous | Next
Chick on the image for model information and download options,

Best Proposed Assortment »

Image Library *

Logos *»

Manufacturer's Brand =

Brand Essence Film

VMD (Visual Merchandising)

Catalogue *

Glossaty of Watches

Cate of Walches

|Gend Stztng 1 e 762 58

Calibre nformation 55 (23

Operating Manual M SB oL M S8 ol e ss  we

OQunmions Sree 100M ::!mx o . 100M :::mx o . Tm x”" o .

List of Distributors 4500969410734 4900969410741 4900969419560

Senice Network

Extranet

Website =l

Click “Setup Details “in the above.
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3 Image Library (cont.)

The Setup Details page provides to allow users to select show/hide the fields in feature table.

) SLIKD Hong Kong Ltd, - Microsoft Internet Explorer

PU

LSAR

=l0IXIthe details
utorial of this site chick here
¥ Cal Code ¥ Band Code
::l ¥ Case Material W Gender
read| ¥ DF1 ¥ water Resistance
::;"‘ ¥ case Code ¥ category Proviovs | Next
¥ Bezel ¥ Role
¥ Crown ¥ Lead Time
¥ Glass Code ¥ Ean Code
¥ Case Back V¥ DF2 i
¥ Band Material WV std. FoB
¥ Band Construction ¥ DF3
¥ Band Clasp ¥ Remark
78 b
s save | cancel | —
POAIX G
:g Copyright®2005, SEIKO Hong Kong Ltd, le::m [=s] 4

(e
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3 Image Library (cont.)

Advanced Search

2 SEIKD Hong Kong Ltd. - Microsoft Internet Explorer =121 .’_‘J
Admin Pages Pulsar » Lorus » Alba To view a Tutorial of this site click here
Home
\Who We Aire & History Advanced Search
Pulsar Today/ Mission
Selling Features of Pulsar Select your search criteria below then click the Search button o Back
Over Competition
Selling Features of Pulsar _ Favorites g
Watct Model No#:
= . ! ’4‘ [ 1. test o
Communication Price Range: | to
Best Proposed Assortment » @ 2. test2
Image Library » Select the Search Field: 37 3. test3
Logos * | j = | Ll 374 €6
Manufacturer's Brand = — [ = [ 5 Mone
e o o | H-_u X
VMD (Visual Merchandising) [orR = | =z - = 77 None
:muﬂ’ T IOR :I I j = I :J D’ 8. Mone
ssary of Watc|
Care of Watches R Wl | H - | H | (e v
Band Sizing |OR ;I I _:] = [ ;I [ 10. None
Calibre Information IOR LI I El - I LI 3 11. None
Operating Manual D}’ 12. None
OR = - = -
Download Area I :I I ‘—] I j D’ 13. Naone
List of Distributors for = | = = | =l I
Service Network
OF = - = - =
e I = I E I H [ 15. Nane
i Search | Reset | Save Search Criteria
Change Password
Help »
Copyright©®2005, SEIKO Hong Kong Lid o
=i

You can search products by the following criteria:
Model No# , Price Range , Select the Search Field , Favorites.

aick “Search*” to search products.
eick “Reset" to reset the criteria.
aick “Save Search Criteria“ to save the current search criteria.

~Slick “Back* to back to the previous page.

ethe “Favorite” menu, click Wedit “Search Criteria“.

eick the name of “Search Criteria® to search products with saved criteria.

12 SEIKO Hong Kong Ltd.




3 Image Library (cont.)

1. When click “Save Search Criteria“ as below, you can open the “Favorites List".
2. And then save the search “Criteria“ into “Favorites®.

) SEIKO Hong Kong Ltd. - Microsoft Internet Explorer

Admin Pages Pulsar » Lorus « Alba To view a Tutorial of this site click here
Home
WWho We Are & History Advanced Search
Pulsar Today! Mission EE td. - Microsoft Internet Explorer X _,.,IQ]_!‘J
Selling Features of Pulsar, " Back
Over Competition Favorite List
Selling Features of Pulsar ’ ) Favorites
Watch EreempTE 01 0wing and key in the Name you want to save. 7 1. tes
m . G, T e:
s ¥ 2. test2
Best Proposed Assortment| 1 |fe¢3t Water Resistance = 100M Or Band 2 tests
Image Library > Material = PU Or CAL Code = "hhh" Or :
Logos » Category = PER Or Role = CO [ 4 66
Manufacturer’s Brand 2 r Price == 1000 and Price == 299 D’ §. Naone
Brand Essence Film - 1 o Q7 6. tone
VMD {Visual Merchandising 3 2sistance = 100M Qr Band e
Catalogim > Material = PU Or CAL Code = "hhh" Or 7 7. Mone
Gloss of Watches Category=FPER OrRole=C0Q F= D’ 8, None
Care of Watches. C4 s Water Resistance = 100M Or Band [ 9. Mone
- Material = PU Or CAL Code ="hhh" Or &
Band Sizing B’ 10. Mone
- v Category = PER OrRole= C0O
Calibre Information : &7 11. Mone
Operating Manual Cs | [ 12. one
Downioad Area Cs I [Z 13. Mone
ey s C7 | & 14. Mone
Extranet o (] |3 95: tooe
i Search I Re{ I Save Search Criteria
Change Password
Help »

Copyright®2005, SEIKO Hong Kong Ltd,

j |
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o3 Print Instructions

The “Read Print Instructions” provides “Print All* and “Print This Page” instructions.

Print All

Image Library
PRESTIGE - CHRONOGRAPH

Print This Page @ Setup Details = Advanced Search

Read Print Instructios
Page 10f 11

Click on the image Tor model information and download options.

PFI0S5X1
7162 SS
Ss
MC sS S0
PR MBP o
WR PRE HE 4
4900969397967

1. On the screen above, press “Print All".

Internet Explorer - Security Warning

Do you want to install this software?
D Name: MeadCa's Scriptis

Publisher:
™ Always install software from “Mead & Company Limiked”
" Never install software From "Mead & Company Limited”
i+ Ask me every time

Fewar opkions

mstal |

it Instal |

Next

PEMAX1
762 BS

4500969405143

your computer. Only install software from publishers you trust,

While files from the Internet can be useful, this file type can potentially ham]

£

2. User would be warned about installing “MeadCo’s ScriptX” plug-in. Press “Install” to

continue printing procedure.

SEIKO Hong Kong Ltd.



@3 Print Instructions (cont.)

Print All

SEIKD Hong Kong Ltd, - Microsolt Internet Explorer

Fle Edt Yew Favorkes Jooks Help

bew ¥ bt i_peintall aspx

£& with Microsoft Office Word PH

PRIZITH [ 15
baL -1 [ by TREE [
[ [ [ (5% [ [ 3]
MCTECE (B0 | MC (588 (] MC [58 [500 ME ] [+ |
[LBP 1] | PEIX 1] PR P2 (] | PAIEIN [
(TMPRE VO[3 WOMIPRE €0 14 WR TPRE [C0 4 WR IPRE [CO |4
OGS 1 43 | OO0 ThED | U004 O | GO0 1 0050

rm— r— ﬂ{a

1 [ \ | Pakelel

3 Themess “File > Print...“ or press “Ctrl + P*.
(Bprint 20 x|
. &

General [Dphom'

- Select Printer

Add Printer

|
' =l
Status:  Ready [~ Printtofle  Prefsrences |

Location:

iy Find Printer...
~Page Range

@ Al Mumber of copes: |1 33

€ Selection. € Current Page

" Pages: |1 ¥ | Cllste ; £,
Enter either a single page number or a single 12 112

page range. For example, 512
C Pint D Cancel | Ao |

4. Select the right printer then press “Print".

15 SEIKO Hong Kong Ltd.



@3 Print Instructions (cont.)

Print This Page
Image Library

IGE - CHRONOGRAPH

Page 2 of 11 Previous | Next

4900969410734 4500969410741

1. On the screen above press “Print This Page".

16 SEIKO Hong Kong Ltd.



@3 Print Instructions (cont.)

Print This Page

3 SEIKD Hong Kong Ltd. - Microsolt Internet Explorer

fle Edt View Fgvortes Jooks Hebp

New ¥ &t i_peintone. aspxTpage=2

Edit with Microsoft Office Word PH

Save As...

Send »

Import and Export...

Properties

Work Offine

Close [ PFI281X1
AR T mEx] (T7e2 |n

SS SSGP AT

M SSWe M MC_ISCB  |TISS  |SLE 5
PR [PB438X G PR [PB438X PR [PCA94X
100MPRE  jCO |4 100M [PRE {100 [PRE ___[CO
4900959419560 4300969419577 4300969411557

2. Then press “File > Print..." or press “Ctrl + P*.

(&print : 20 x|
General ll:lptioml P
- Select Printer
\ gl &
B & % -
Add Printer Microsoft J
PINTER i# Office Doc...
: -l
Status:  Ready [~ Printtofile Preferences |
Location:
Conment Find Printer... |
~ Page Range
& Al Mumber of copes: |1 33
€ Geleclion € Current Page
 Pages: |T ¥ Coliste FoL I,
Enter either a single page number or a single [ 12 112
page range. For example, 512
s | |

3. Select the right printer then press “Print".

SEIKO Hong Kong Ltd.



«3 Detail Page

The “Detail Page” provides all information about the product as well as features.

1. Click the image as shown below.

PULSAR

it's all in the details

Admin Pages Pulsar + Lorus » Alba Toview a Tutorial of this site chck here

Home

Who We Are & History Image Library

Putsar Today! Mission PRESTIGE - CHRONOGRAPH

Selling Features of Pulsar Priot This Page « Primt ARl = Setup Details = Advancid Search

Over Competition Read Print Instructions

mmum Page 2 of 11 Previaus | Next
Chck on the image for model information and download options.

18 SEIKO Hong Kong Ltd.



o3 Detail Page (cont.)

PULSAR

it's all in the details

Pulsar « Lorus « Alba Toview a Tutorial of this site click here

Image Library
PRESTIGE - CHRONOGRAPH
nulmpmo Click image 10 Enlarge OM
1253%1
: oL
Dowenload ts your compuler fow ¥
Photo EPS None > g v PZO2SX - f

Photo JPG None

Click “Print This Page".
To “Print", click “File” and then “Print".

Click “Back” to back to the previous page.
Download images of EPS, JPG format.
o Click the image for enlarging.

o Information of the product.

19 SEIKO Hong Kong Ltd.



o3 Download

“Download” — Allows you to transfer a single selection at a time, directly to your computer.
Files that may be downloaded include:

IMAGES
LOGOS
MANUALS

1. Click “Download” and then you can choose “Open” or “Save” the file in “File Download”
window.

Filg Lol IB

b ] Some files can ham your computer. F the file information below
-.'/ looks suspicious, or you do nat fully trust the source, do not open or
save this file
File name: SNLOO1.ps
Fil= type
From seiko.dev.multi-ad.com

Would you like 1o open the file ar save i to your computer?

| Open | l Save I[ Cancel | ’ Mare Info

[#] Always ask before opening this type of file

2. Click "Open” to view the file.
-OB-
Click “Save” to save the file on your desktop or in other desired folders.

3. Like other files, double click “My Computer” and then locate your file. To open, please double
click your file.

20 SEIKO Hong Kong Lid.



@3 Download PDF

You need Adobe Reader (version 4.0 or higher) to view these files. To download Adobe Reader,
please go to http://www.adobe.com.

PULSAR

it’s all in the details

Admin Pages Pulsar « Lorus « Alba To view a Tutorial of this site click here

Home
Who We Are & History Manufacturer's Brand

Pulsar Today! Mission

Selling Features of Pulsar The Manufacturer's Brand will provide you the detials about the quality in
Over Competition production of our products.

Selling Features of Pulsar
Watch

Communication Please click below file to see the details.

Best Proposed Assortment »
Image Library » manufacturer's brand1.pdf

Logos *

Manufacturer’s Brand
Brand Essence Film

VMD (Visual Merchandising)
Catalogue *

Glossary of Watches

Care of Watches

Band Sizing

Calibre Information
Operating Manual I
Download Area

List of Distributors

Service Network

Extranet

AAL b i :J
o Click “Manufacturer's Brand".

o Click “manufacture’s brand1.pdf” to download the “PDF document®.

21 SEIKO Hong Kong Ltd.



3 Download PDF (cont.)

2} SEIKO Hong Kong Ltd. - Microsoft Internet Explorer i =101 x|

PULSAR

_ it's all in the details
e - /

Admin Pages Pulsar » Lorus « Alba To view a Tutorial of this site click here
o
Pulsar Today/ Mission Please select the required manual using the drop down box above. The manual is

Selling Features of Pulsar identified by the Calibre No.

e Conmpist i} You can find the Calibre No. on the back of your watch as shown:

Selling Features of Pulsar

Watch

Communication

Best Proposed Assortment »

Image Library »

Logos *

Manufacturer's Brand

Brand Essence Film Calibre No

VMD (Wisual Merchandising)

Catalogue *
Glossary of Watches Please choose a calibre no. [laaa o
Care of Watches

Band Sizing Please select a language [Arabic 'I

Calibre Information

Operating Manual o Choose o
Download Area

List of Distributors
Service Network
Extranet

[ .

o Click “Operating Manual”.
e Select “calibre no.” and “language” for manual.

o Then click “Choose” to download.

22 SEIKO Hong Kong Ltd.




@3 Download Video

PULSAR

it's all in the details

- /

Admin Pages Pulsar + Lorus « Alba To view a Tutorial of this site click here

Home .
Who We Are & History rand Essence Film

Pulsar Today! Mission

Selling Features of Pulsar Mow the Pulsar Brand Essence Film is available for you to tell the Pulsar story to
Over Competition your retailers and consumers in the most powerful way ever. With this film, you

can give them more impact and a more emoctive explanation of this theme, The
Selling Features of Pulsar difference is in the detail’. :

Watch

Communication It is our belief that you will make the best use of this film to present what Pulsar
Best Proposed Assortment » stands for.

Image Library »

Logos * : : .
AR e Please click below file to see the Pulsar Brand Essence Flim.

Brand Essence Film PULSAR:
VMD (Visual

Catalogue »
Glossary of Watches
Care of Watches
Band Sizing

Calibre Information
Operating Manual
Download Area

List of Distributors
Service Network
Extranet

Mlabndia

o Choose “Brand Essence Film".

e Click “PULSAR.wmv” to download the video file.

23 SEIKO Hong Kong Ltd.




o3 Catalogue

1. Click “Catalogue” and then Click “POS" as shown below.

PULSAR

it's all in the details

Admin Pages Pulsar + Lorus « Alba To view a Tutorial of this site click here

Catalogue *

Home
mowomssmsay [
Pulsar Today/ Mission
Selling Features of Pulsar
Over Competition -
Selling Features of Pulsar ' == |
Watch -
Communication
Best Proposed Assortment » o tvaliro T\
Image Library » e e - ! if':'h :f
- s ICINS B gl

Logos * Wanm aix cr:fltﬁt? . proth 7 g }f.‘#..\ g1 Chi 7 |

Tmitterscote 5 NV A a, T e
Ma i a lﬂwl:l:q - & [ ’)‘h""{q e -uml‘ mf- hasnhder
an (Visual Merchandising) Tainarye’ ; ‘ot {“",’,’i' f.c'?,}ff' é ‘

SAR PULSAR

L PULSAR

24 SEIKO Hong Kong Ltd.




o3 Catalogue (cont.)

2} 5H KD Hong Kong Ltd. - Microsoft Internet Explorer -[E‘ﬂ]
Catalogue
POS

Page2of 5 o o Previous | Next

Click on the image for moded information and downboad options.
PULSAR PULSAR |
PULSAR PULSAR : :“
PULSAR FLASAR PULSAR = vam
- PR
PULSAR
Model Hoi PPOP-03-08 Model Ho1 PPOP-04-0% Model No: PPOP-04-10
S5.FOB Prica: S.FOB Price: S.FOB Price:
Itermn: Pulsar Window Itarm: Pulsar Loge Itar: Pulsar
Display (com: Stickar Presentation
with watch st Dimansion: A3 Tray
%1 pes) o i 36,0 (
i AN §Ien: .0 (w) x 22.9
Dimansion: Main - 44.0 (v) Cou::;;:‘ g (d) = 2.4 (h) em
* 30.0 (d) x Material: Sticker Sountry of China
48.0 (h) em ongin:
Small x 2 - 24.6 UT: 1 month Material: Wood
(w) x 20.5(d) X pmin O " ’
M0 - ORI LOR UT: 50 days —
Comae with 51 pecs Min Ordar Qty: 1,000 pes
watch stand:
Country of China
origing
Materiali Wood, Metal &
Acrylic
UT: 50 days

|Help >

o Shows how (many) total pages and what page you are at.
o Click “Previous” to back to the previous page and “Next” to go to the next page.
o Click the picture for details.

o Information of the product.

25 SEIKO Hong Kong Ltd.



©3 Abbreviation Page

Click “Help” and then click “Abbreviation”

2} 5£1K0 Hong Kong Ltd,

Microsoft Internet Explorer
v o

PFI23TXA
1162 SS
£~
MC S
PR PZag2X
WR PRE co
4900969410406

Ean | Det ails.

K0
G
4

Edit | Detalls

26
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3 Abbreviation Page (cont.)

The Abbreviation page provides the detail description of the abbreviation of the feature table in

Image Library.

3 SEIKO Hong Kong Ltd. - Microsoft Internet Explorer

Abbreviation
Group Field Abbreviation Description

Head  Case material 358 Stainless Steel case with Brass bezel
SSP Stainless Steel case with Plastic Case
T Titanium case
BS Brass case
TIS Titanium case with Stainless steel bezel
SS Stainless Steel case

Case code GPHC  |Gold plated and Carbonized Titanium coated case / S8 back

GPDP  |SGP and PDP case /S8 back i
THCSS . Carhonized Titanium coated bezel, 5SS case / SS back
']'GF'TI PDP bezel, Titanium case / Titanium back
TGPDP  |PDP and SGP bezel, 88 case / S8 back
PDP |Palladium Piated case /S8 back
PGP Pink Gold Plated case / S5 back
5GP Gold Plated case / SS back
88 Stainless Steel case / 55 back

27 SEIKO Hong Kong Ltd.




o3 Download Area

PULSAR

3 | R it's all in the details

Admin Pages Pulsar + Lorus + Alba

Toview a Tutorial of this site click here

Who We Are & History Download Area

Pulsar Today/ Mission

Selling Features of Pulsar It is Download Area
Over Competition

Selling Features of Pulsar

Watch Itis item 1
Communication

Best Proposed Assortment » It is item 1.1t
Image Library »

Logos *

Manufacturer's Brand
Brand Essence Film

VMD (Visual Merchandising)
Catalogue *

Glossary of Watches

Care of Watches

Band Sizing

Calibre Information

= ‘

Service Network
Extranet

S, =

o3 Help

Help page provides support on user guide, Internet policy, Abbreviation, File formats and
Technical support.

o3 Home

Click “Home" to back to the main page of the brand you're currently browsing.
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3 Change Password

Click “Change

23 SEIKO Hong Kong Ltd.

Home
VWho We Are & History
Pulsar Today! Mission

Selling Features of Pulsar
Over Competition

Selling Features of Pulsar
Watch

Communication

Best Proposed Assortment »

Image Library » wrsander,
belicres .
Logos » f:i'."“,. L] i <
Loves butterscoteh puwiding O NS ARG, TS dooet

Manufacturer's Brand SE e & ......'. : g o ool bl
Brand Essence Film Neonadree

i [ormer I\M"’"
\;DWWWM A Zears o P Soltr
Glossary of Watches ‘ g pULSAR
Care of Watches
Band Sizing
Calibre Information
Operating Manual
Download Area
List of Distributors
— PULSAR

Change Password

Password".

Microsoft Internet Explorer

i
v valinn 1\

L]
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3 Change Password (cont.)

7} SEIKO Hong Kong Ltd. - Microsoft Ink
Change Password

User: admin
Old Password : "_
New Password : [

Confirm Password : I-

.'Save I Cancel

Enter old password in the “Old Password” field.

Enter new password in the “New Password" field.

Re-enter the new password in the “Confirm Password” field.
| Click “Save” button to save the new password.

| Click “Cancel” button for cancellation.
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5™ FLOOR, YING TUNG INDUSTRIAL BUILDING, 802 LAl CHI KOK ROAD, KOWLOON,
HONG KONG

31 SEIKO Hong Kong Ltd.



